“If you truly love nature, you will find beauty
everywhere”.
Heard — Vincent van Gogh

Nature PhOtO graphers Still hot but fall is coming

Halloween
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CONTEST UPDATE

Anita Oakley (anitacak@outlook.com) has agreed to lead the contest committee for the 2023 Heard
Museum Photo Contest. Jackie Ranney (jackieranney(@aol.com) is handling publicity.

If you have any questions about the contest, please feel free to contact either of us. If you belong to
photography-oriented Facebook groups, other photo clubs, or have photographically inclined friends please let
them know about the contest!

Submissions begin: March 25,2023
Submissions end: April 15,2023

Last day to accept payments: April 17,2023
Judging: Negotiable, but around April 21,2023
Awards Ceremony: May 14,2023

We have some exciting new categories in addition to the ones we had last year:

* People and Nature — Images depicting a person or people interacting with nature. May include people
enjoying nature or the way people affect nature.

* Seen at the Heard — Images captured anywhere outdoors at the Heard Museum, including along the
wildlife trails, in the butterfly exhibit, or at the Dinosaurs Live exhibit.

 Aerial Images — Images captured from a drone, helicopter, or plane. Must be nature-related.
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President’s Message

Hello Everyone,

As we come up on the end of the year we're going through
many changes.

First, we’re moving our meetings to 10AM-12PM, still on the
second Saturday of the month, to allow the Heard Nature
Museum to use the room in the afternoons.The only exception
going forward will be the December Member’s Choice meeting
which will continue to be in the afternoon. More coming up as
we finalize the arrangements.

Next, starting with the December 2022 meeting we will go to
in-person meetings only.We will continue to use Zoom for
remote presentations when we need to, but the meetings
themselves will be only in-person.

With the end of the year, we need to nominate and hold an
election for 2023 officers.This is part of the club’s bylaws, so it is
important that it be done properly. If you're interested in taking
a more active role in the club, helping the club grow, and helping
to guide its future | want to encourage you to let a member of
the nominating committee or one of the current officers know
about how you'd like to be help.We can’t keep the club going
without your help.

From talking to members about who should be on the
nominating committee, I’'m hearing that a lot of us don’t feel that
we know enough of the members of the club as well as we
should.We’re not comfortable with trying to volunteer when we
don’t know enough of the club’s history and how the club really
works.
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| don’t really have a good answer for that, as | feel the same way
most the time. | joined in September of 2019 just before Covid
closed down everything. | went to four meetings before we went
to all remote meetings and pretty well stopped the field trips. But
last year when the club faced a crisis because we had to have a
president, | said I'd try to fill the job because the club was
important to me, and the club was going to have to disband if
there wasn’t a president for 2022. | hope | haven’t done too badly,
and I’'m willing to serve another year if elected but I’'m never very
sure about what I’'m doing and more importantly, not doing. Of
course I've had a lot of help, but most of the current officers have
been carrying the club through all the adaptations we had to make
for Covid and coming back to full meetings and a good schedule
of field trips.

We need more help so that the people who carried the club for
the last couple years can feel like the club will go on, that the
members are interested enough to support the club by
volunteering to help with coordinating a field trip or contacting
schools to get out information about the upcoming annual
competition or bringing snacks to the meeting.

We’re hoping that by moving to in-person meetings more of the
newer members to find out that we're just a bunch of
photography nerds who enjoy taking pictures, especially nature
photography, more than being in them and that if you combine
everyone in the club, we've got a pretty big list of where to go and
a large body of knowledge about how to take better pictures.
Heard Nature Photographers Club is a great place to make
friends who enjoy being outdoors taking pictures, sharing their
knowledge, and helping each other to get the picture that shows
what you saw in the moment. But to do that we need your help.

Thank-you
Doug Boone

dougboone5@gmail.com
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Boots Made for Walking, Guy Huntley

Page 5

TREASURES CLOSE TO HOME

As another of our Nature Plus! field trips, on
September 17 twelve of us gathered in historic
downtown McKinney to go exploring with our
cameras! There was a lot to shoot — murals, sidewalk
displays, store fronts, window displays, historic
architecture, antique stores, planters with blooming
flowers, the historic Chestnut Square Farmer’s
Market, a Mexican celebration and of course, the
newly decorated silos. We had a challenging
lackluster sky so it will be fun to see the video at our
next meeting revealing what our group came up with!

Doug Boone, Steven Earles, new member Kim
Franklin, Janice Goetz, Guy Huntley, Brigitte Kiba,
Grace and Jimmy Lee, Jackie Ranney, Craig Rowan,
Victor Stamp and Terree Stone all braved the heat
and brutal humidity to come away with some
treasures. Thank goodness lunch at The Pantry
provided air conditioned relief from the heat and a
chance to visit with each other.
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Bloom Bravely, Jackie Rainey

Interesting discoveries during our visit: Kim Franklin happened
upon a “Ghost Busters-look”™ ambulance on S. Tennessee near
Davis Street. Steven Earles alerted us to a neat photo op of
the silos from the top of the parking garage at the corner of E.
Herndon Street and S.Chestnut Street. Might want to take a
telescoping lens with you if you go.This free parking garage
has elevator access to its roof if you aren’t driving. For a
close- up look, the silos are located at 401 E. Virginia Street.

Downtown Antiques, Brigitte Kiba
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Hidden McKinney, Jackie Rainey

For more information on the silos mural and the

artist: https://www.npr.org/
2022/09/06/1120168588/mckinney-texas-guido-

van-helten-grain-silo

Silos, Jackie Rainey
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Mural, Grace Lee
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The Rock Church, Cranfills Gap, TX (Rugust 2022)
ADYENT URE

What a delightful and fun experience this trip proved to be! Thanks to Anita Oakley and Terree
Stone, everything went smoothly and we learned a lot about photographing the Milky Way!
Anita even conducted a Zoom meeting ahead of time for the participants to discuss logistics
and provide advice and instructions on Milky Way photography.

We had |3 photographers (and 3 spouses who joined us for dinner): Doug Boone, Debbie
Conard, David & Cheryl Duckworth, Steven Earles, Janice & John Goetz, Bridgett Kiba, Anita
Oakley, Jackie Ranney, Asad Siddiqui,Victor Stamp, Terree Stone, David Valdez, George & Linda
Vardas who all made the two hour (plus!) drive to the middle of nowhere!

Dinner was at The Horny Toad Bar & Grill in Cranfills Gap. Their staff really worked with us to
get us all in and out quickly. Needless to say we were anxious to get to the Rock Church
during the remaining daylight hours to familiarize ourselves with the terrain and pick our spots
to start the first part of the shoot.

Pre-dark preparation and observation was critical! Remember; our staging area was actually in
the cemetery and once it got dark, it was REALLY dark (think walking around in your garage
with absolutely no light...)! Anita set up lights inside the church to highlight the stained glass
windows testing to be sure the light levels were just right. Terree arranged a “border” of bright
green traffic cones so we didn’t get into each other’s shots. This really turned out to be helpful.
Whenever anyone needed to turn on lights, there was even a procedure for us to follow so no
one had images spoiled.


http://www.hornytoadbar.com/
http://www.hornytoadbar.com/
http://cranfillsgaptexas.com/
http://cranfillsgaptexas.com/
http://rockchurch-gap.com/
http://rockchurch-gap.com/
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The Green Cones
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(A side note —Terree, Anita and Jackie arrived a day early with the intention of confirming our
logistics and testing light levels.VWhen we arrived at the cemetery with the expectation that we
were the only ones to be there, imagine our surprise when we discovered about |5 other
people there from different groups. There were no group leaders or sense of organization for
the other folks and people wandered willy-nilly getting into each other’s shots, turning on lights
at inappropriate times for those who were doing long exposures...... it was a mess.) So glad
Anita and Terree had thought out these possibilities ahead of time!)

When darkness fell, we all settled into taking our shots, talking with each other to see how our
images were coming out, making and taking suggestions and generally having a good time
learning and succeeding. Once it was confirmed that everyone had the shots they wanted from
the cemetery side of the church, those who wanted to try star trails moved to the highway
side of the church. Some of us were experienced with this, others of us were in the learning
stage.

As the evening progressed, a few of our group left earlier than those of us who stayed until
1:30 a.m. or so. Needless to say, an early alarm wasn’t on schedules for the following day! The
next morning though, a few of us went back to the church to check the grounds to be sure we
had not left anything to detract from the area (water bottles, papers, etc.). All in all, it was a
rewarding experience and it is hoped that we will have another opportunity to shoot the Milky
Way as a group.
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Horney Toad, Brigitte Kiba

Rock Church, Janice Goetz
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Star Trails, Terree Stone
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Meetings

Heard Nature Photographers Meeting Schedule, 2022
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in person and on Zoom

an e-mail will be sent to members
with the ZOOM link

NEW MEETING TIME:
10:00 AM, Laughlin Hall

DATE SPEAKER TOPIC
October 8, 2022 Alan Murphy Ingredients of Great Bird Photography
November 12, 2022 Carol Highsmith Library of Congress Photography

December 10, 2022

Members Choice

Meetings will be ZOOM and in person,
October and November.

The December meeting will be
Members Choice and Holiday
Gathering, in person.

Beginning in January, all meetings
will be in person.


https://www.alanmurphyphotography.com/
https://www.alanmurphyphotography.com/
http://carolhighsmithamerica.com/
http://carolhighsmithamerica.com/
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About Alan:

OCTOBER SPEAKER Growing up surrounded by the beautiful countryside’s of both Ireland
and England, at a young age, Alan developed a love for birds and nature.

He was a quick study of birds and upon immigrating to the United
States in the early 1980's,Alan was thrilled to find many new species

W and their habitats. After studying field guides, he too wanted to
capture similar images, and so began his quest to learn photography.
Much of Alan's spare time became devoted to chasing the perfect shot.
His artistic background cultivated his creative use of perches with
uncluttered backgrounds and excellent lighting. Over the years this

became Alan's signature: gorgeous perches paired with beautiful birds
showcasing their natural environment with simple elegance.

What began as a peaceful and passionate hobby, Alan has refined into a
photography business. Besides the numerous photographs he loves to
acquire,Alan is equally enthusiastic about leading workshops and
teaching other photographers how to capture the perfect image. He is
an award-winning photographer with numerous publications, a Nikon
Professional Service Member, a Wimberley Professional Service
Member, and the author of several e-books and educational videos. He

Topic: enjoys traveling the country, speaking at festivals and photo clubs. Alan
INGREDIENTS OF GREAT BIRD and his wife, Kim, raised their children in the Houston area, travel
PHOTOGRAPHY domestically and abroad, enjoy nature and their rescue dogs.

Website: Ebooks & Videos:

https://www.alanmurphyphotography.com/ https://www.alanmurphyphotography.com/shop

Workshops: Publication Covers:

https://www.alanmurphyphotography.com/ https://www.alanmurphyphotography.com/press

workshops

Alan’s favorite images:
https://www.alanmurphyphotography.com/favorites



https://www.alanmurphyphotography.com/
https://www.alanmurphyphotography.com/
https://www.alanmurphyphotography.com/shop
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https://www.alanmurphyphotography.com/
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Belted Kingfisher, Alan Murphy
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Topic:
INGREDIENTS OF GREAT BIRD
PHOTOGRAPHY

PROGRAM DESCRIPTION:

Alan’s talk intitled “Ingredients of a Great Bird
Photograph” will discuss the following topics:

How to choose the best image to process.
How to compose and crop your images.

How to choose the best wing position.

How to include habitat in your images.

How to choose the best shooting perspective.
How to find the best background.

How to work with virtual reality.

How to find an image within an image.

How to choose the right dept-of-field.

How and when to include reflections.

How to add drama, action and interest to your
imagery.

FYI: This talk is also one of my videos that |
sell, so if they feel they would like to own all
the info in the talk, then they can purchase that
video. | would be happy to set up a 20%
discount for that and all my ebooks and videos
for your members.



Issue #10: October 2022 Page 17

Atlantic Puffin, Alan Murphy
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Bald Eagle, Alan Murphy
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ROB HULL

If you are a Canon user, there is a workshop tailored just for you. Rob Hull, a Lifetime member and former president of
Heard Nature Photographers, is hosting the Canon Advanced User Workshop on November 5 & 6. It’s a hands-on, 2-day
workshop that is laser-focused on Canon DSLR and mirrorless cameras.

Rob will be joined by Bob Malish from Canon. Bob is one of those guys who travels the world supporting professional
photographers assigned to events like the Superbowl, Olympics, and Formula 1 races.

It doesn’t matter if you’re a seasoned professional or an aspiring amateur, you will discover more about your camera than
you ever thought possible.

Take advantage of a $50 discount offered to club members. Just use the discount code CAU-HEARD when you check out.
For more information and to register, visit Rob’s website at www.GreatPhotography.com/canon.

Rob will also be hosting a Camera Flash Workshop on November 12 & 13. Check out his website for details: https://
www.greatphotography.com



http://www.GreatPhotography.com/canon
http://www.GreatPhotography.com/canon
https://www.greatphotography.com
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ROB HULL PHOTOGRAPHY
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ROB HULL PHOTOGRAPHY
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HEARD NATURE PHOTOGRAPHERS
2022 FIELD TRIP SCHEDULE

DATE

TIME

TRIP/LOCATION

ADDRESS

ADDITIONAL INFORMATION

Saturday, October I, 2022
9:00 AM - 11:30 AM

Chandor Gardens

711 West Lee Avenue
Weatehrford, TX 76086

jmam

To register: please go to the website:

https://
www.heardnaturephotographers.com/

October 22, Saturday
NATURE PLUS

9:00 am

Mid America Flight Museum

602 Mike Hall Pkwy,
Mount Pleasant, TX 75455

To register: please go to the website:

https://
www.heardnaturephotographers.com/

November 4-5-6,
Fri/Sat/Sun 2022

Beavers Bend State Park

Southeast Oklahoma

To register: please go to the website:

https://
www.heardnaturephotographers.com/

Recommend making lodging
reservations ASAP.

As of 5/27/2022, Lakeview Lodge
within the park is still under
renovation.

**NATURE PLUS is a designation for a field trip that includes “the hand of man” subject matter, in addition to nature
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CHANDOR GARDENS
FIELD TRIP ANNOUNCEMENT

DATE/TIME: OCTOBER 1, 2022

Saturday October 1, 2022
ARRIVE: 9:00 am

DESTINATION:
CHANDOR GARDENS

711 West Lee Avenue
Weatherford, TX 76086
(817-598-4334 )

WHERE TO MEET:
In the parking lot

COST:
S5/pp (Tickets are to be purchased inside the on-site house.)

WHAT TO BRING:

Comfortable walking shoes

Your favorite walk-around lens and possibly others!

Bottled water

Important: .

e Tripods are not allowed due to the narrow pathways.

e The 30’ waterfall mentioned on their website is still being reworked.
e Photography inside the on-site house is not permitted. w*Photography by Wy Roberge. Used with permission.
We will be leaving by 11:30a.m. at the very latest since they have a wedding scheduled in the evening

(the wedding party is scheduled to begin arriving at 11:00 a.m.)

Additional gardens in Weatherford that members may choose to visit on their own after our lunch:

Clark Gardens www.clarkgardens.org

Registration is available on our website.

YOU MUST BE A PAID MEMBER TO PARTICIPATE IN FIELD TRIP EVENTS


https://weatherfordtx.gov/170/Chandor-Gardens
https://weatherfordtx.gov/170/Chandor-Gardens
http://www.clarkgardens.org
http://www.clarkgardens.org
https://weatherfordtx.gov/170/Chandor-Gardens
https://weatherfordtx.gov/170/Chandor-Gardens
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**Photography by Wy Roberge. Used with permission.

Chandor Gardens captures both the ornate design of
ancient Chinese architecture and the elegance of a
formal English garden. The 3.5-acre estate leads its
visitors on a meandering path of beauty and
wonderment.

A recent visitor emphasizes how much care the
Gardens staff has taken to keep the vegetation lush and
thriving throughout the extreme weather conditions
recently experienced.
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NEW DATE!!! MID AMERICA FLIGHT MUSEUM
OCTOBER 22, 2022

FIELD TRIP ANNOUNCEMENT
SATURDAY OCTOBER 22, 2022
NATURE PLUS!

DESTINATION:

Mid America Flight Museum
602 Mike Hall Parkway
Mount Pleasant, TX

www.midamericaflightmuseum.com

Vintage and historic military aircraft.

The Museum is dedicated

to preserving the memory of Veterans

and the planes they flew to defend our freedom.

DATE/TIME:

Saturday October 22, 2022

ARRIVE: 9:00 am

The Museum opens at 8:00 a.m. Should you wish to arrive that early,

please feel free to do so (just identify yourself as being from the Heard Nature Photographers).
There is no charge for admission or parking.

) YOU MUST BE A PAID MEMBER TO PARTICIPATE IN FIELD TRIP EVENTS
Trip Leader: Steven Earles

Lunch 12:00 pm:

We'll gather at Laura’s Cheesecake & Cafe, 109 N. Madison Avenue in Mount Pleasant. Order at the counter in the back-left
corner inside the restaurant. then your mean will be brought to your table. The food is fresh, delicious and servings are
generous. A delightful selection of cheesecakes awaits, too...either by the piece or as a whole cheese cake to take home.
https://www.laurascheesecake.com/



http://www.midamericaflightmuseum.com
http://www.midamericaflightmuseum.com
https://www.laurascheesecake.com
https://www.laurascheesecake.com
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Equipment:
Tripod/monopod; a selection of lenses, comfortable walking shoes, bottled water.
(The Aircraft are in multiple buildings.)

Tidbits:
There are over 60 aircraft at the Museum and the majority of them are flight-worthy.
About 40-45 aircraft are on display at this point in time.

- They have two of the four known flyable planes that are Pearl Harbor survivors.

- Warbirds and vintage aircraft...bombers, fighters, helicopters, observation and transports.

- The collect is easily accessible. There are no ropes, chains or fences around the aircraft.

- Check out the website’s many stories about the aircraft and their crews...fascinating!
www.midamericaflightmuseum.com

- There is plenty of seating in the Museum’s many buildings.

Reqgister on our website to sign up for this field trip!
Final details will be sent to the registrants a few days before the event.
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BEAVER’S BEND STATE PARK

NOVEMBER 4-5-6, 2022

FIELD TRIP ANNOUNCEMENT
FRIDAY-SATURDAY-SUNDAY, NOVEMBER 4, 5, 6, 2022

DESTINATION:
Beaver’s Bend State Park
Broken Bow, OK

This is far out, it’s hard to predict the exact change of colors so
we

are taking our best shot! So much will depend upon Mother
Nature!

DATE/TIME:
FRIDAY-SATURDAY-SUNDAY, NOVEMBER 4, 5, 6, 2022
ARRIVE: Ideally Friday afternoon/evening Photography by Jackie Ranney

PLANS:

Still being formulated, but here’s a general idea:

- Saturday morning - sunrise photography (about 7:40 am).
- Continue shooting in the park until lunchtime.

- Saturday lunch - as of September 16, 2022, it is still
undetermined if Foggy’s will repoen by the time our field trip iss
happening

- Saturday afternoon - on your own; no “club-organized”
activities.

- Saturday evening - group dinner - location TBD.

- Sunday — departure at participant’s option.

Photography by Nancy Mack


https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
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LODGING:
- Beaver’s Bend State Park has cabins (reservations 580/494-6300) or
go to their website. (The website is not showing

much availability; different than calling!) e Lakeview Lodge (inside the
park)— still under renovation as of 3/6/2022.
Projected completion is September 2022 — they are not yet taking
reservations.

- Check VRBO, Airbnb, booking.com and other vacation rental sites for
houses/cabins. Search Hochatown, OK or
Broken Bow, OK.

- https://guestrez.megasyshms.com/TTPRB/beavers-bend-state-park?
a=2.55111145.375172306.1646529802-356434746.1646529801

STATE PARK PARKING PASS:
Using the link provided above, please review the policy about fees and
a parking pass to be inside of this park.

REGISTRATION:
Register on our website

Final details will be sent to registrants a few days before the event.

YOU MUST BE A PAID MEMBER TO PARTICIPATE IN FIELD TRIP EVENTS

Photography by Jackie Ranney

Photography by Nancy Mack
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https://guestrez.megasyshms.com/TTPRB/beavers-bend-state-park?_ga=2.55111145.375172306.1646529802-356434746.1646529801
https://guestrez.megasyshms.com/TTPRB/beavers-bend-state-park?_ga=2.55111145.375172306.1646529802-356434746.1646529801
https://guestrez.megasyshms.com/TTPRB/beavers-bend-state-park?_ga=2.55111145.375172306.1646529802-356434746.1646529801
https://www.heardnaturephotographers.com/field-trip-registration
https://www.heardnaturephotographers.com/field-trip-registration
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INDIANA

INDIANA: the Hoosier State



https://en.wikipedia.org/wiki/Indiana
https://en.wikipedia.org/wiki/Indiana
https://en.wikipedia.org/wiki/Hoosier
https://en.wikipedia.org/wiki/Hoosier
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Indiana is the19th state to be admitted to the Union on December 11, 1816. The flag has 19 stars to
represent this. The northwest is bordered by Lake Michigan; the remainder of the north border is with
the state of Michigan; the west border is with lllinois and the Wabash River; to the east is Ohio, and to
the south is the Ohio River and Kentucky. It is probably best known for the little race on Memorial Day:
the Indianapolis 500. My guess is that most people who have visited Indiana only pass through and
miss out on some of the little gems that are there.

The biggest is probably the Indiana Dunes National Park and the Indiana Dunes State Park. The state
park is surrounded by the national park. The Indiana Dunes National Lakeshore which was
established in 1966 officially became the Indiana Dunes National Park in 2019. There are 15,000 acres
to roam. The state park was established in 1925 and has over 2,000 acres of stunning terrain.
Combined they offer sandy beaches, rugged dunes, quiet woodlands, numerous wetlands and over 50
miles of hiking trails. It is one of the most biologically rich areas in the nation. There are 46 species of
mammals, 23 of reptiles, 71 of fish, 60 species of butterflies and 350 species of birds along with
various insects (for the bug lovers).

| visited October 2018 and again late February/early March this year and had a short time to visit the
parks each time. Here are a few photos form those trips.

Indiana Indiana Dunes National Park


https://en.wikipedia.org/wiki/Indiana
https://en.wikipedia.org/wiki/Indiana
https://www.google.com/search?client=firefox-b-1-e&q=Lake+Michigan
https://www.google.com/search?client=firefox-b-1-e&q=Lake+Michigan
https://en.wikipedia.org/wiki/Michigan
https://en.wikipedia.org/wiki/Michigan
https://en.wikipedia.org/wiki/Illinois
https://en.wikipedia.org/wiki/Illinois
https://en.wikipedia.org/wiki/Wabash_River
https://en.wikipedia.org/wiki/Wabash_River
https://en.wikipedia.org/wiki/Ohio
https://en.wikipedia.org/wiki/Ohio
https://en.wikipedia.org/wiki/Ohio_River
https://en.wikipedia.org/wiki/Ohio_River
https://en.wikipedia.org/wiki/Kentucky
https://en.wikipedia.org/wiki/Kentucky
https://en.wikipedia.org/wiki/Indianapolis_500
https://en.wikipedia.org/wiki/Indianapolis_500
https://www.nps.gov/indu/index.htm
https://www.nps.gov/indu/index.htm
https://www.in.gov/dnr/state-parks/parks-lakes/indiana-dunes-state-park/
https://www.in.gov/dnr/state-parks/parks-lakes/indiana-dunes-state-park/
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DUNES

This is one of the dunes by the main
parking lot of Indiana Dunes State Park.

Craig Rowen
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Craig Rowen

This is a shot of the pavilion from atop of the previously-pictured dune (p. 32) at Indiana Dunes State Park.
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Craig Rowen

This is a shot of the lighthouse in the Mount Baldy area. You can see a little ice in the water floating towards shore.
It was 12 degrees that morning.


https://www.nps.gov/indu/planyourvisit/mt-baldy.htm
https://www.nps.gov/indu/planyourvisit/mt-baldy.htm

Craig Rowen

The largest “living” dune in the National Park, Mount Baldy moves about four feet every year, burying everything in its
path, including trees. While the beach is open year-round, all hikes to the summit must be led by authorized rangers.
This is a shot of the inland area.


https://www.nps.gov/indu/planyourvisit/mt-baldy.htm
https://www.nps.gov/indu/planyourvisit/mt-baldy.htm
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Craig Rowen

This is the beach side showing more snow.
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This shows how the waves created
a frozen ledge of ice, sand, and
snow. It was about 3 feet in height.

Craig Rowen



Issue #10: October 2022

Page 38

BRIDGES

During the Feb/Mar trip on the way home we
stopped in Bridgeton, IN to look at some of the 31
covered bridges (we got to 6). Most of the bridges
that we stopped at were within a couple miles of
each other. So, we were able to visit them in a
couple of hours, as our time was short. (We needed
to get to Indianapolis by 5 pm). Bridgeton is about
an hour and half east of Indianapolis (non-rush
hour) and about 3 hours from up around the lake.

Bridgeton is one of ten locations for the Parke
County Covered Bridge Festival that is a ten-day
festival that starts on the 2"d Friday in October. The
festival showcases the 31 covered bridges in the
area. Besides the covered bridges, there are
historic buildings for photography.

This is the Conley’s Ford Bridge, and it was built
in 1906.

It is one of the drivable bridges. You can see the dirt
road which is how you access the majority of the
bridges.

Craig Rowen


http://www.bridgetonindiana.com/
http://www.bridgetonindiana.com/
https://www.coveredbridges.com/
https://www.coveredbridges.com/
https://www.coveredbridges.com/
https://www.coveredbridges.com/
https://www.coveredbridges.com/covered-bridges/conleys-ford-covered-bridge-7
https://www.coveredbridges.com/covered-bridges/conleys-ford-covered-bridge-7
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Craig Rowen

This is the Bridgeton Covered Bridge. The original was destroyed by fire in 2006. It was rebuilt in 2006 and is
closed to vehicle traffic. The original was built in 1868.



https://www.coveredbridges.com/covered-bridges/bridgeton-covered-bridge-8
https://www.coveredbridges.com/covered-bridges/bridgeton-covered-bridge-8
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WEBSITES

For additional information on the Indana Dunes
and the covered bridges see the below URLs:

https://www.nps.gov/indu/index.htm

National Park

https://www.indianadunes.com/explore-the-dunes/
indiana-dunes-state-park/

State Park

https://www.coveredbridges.com/

Covered Bridges

https://www.coveredbridges.com/

https://www.coveredbridges.com/covered-bridge-
festival

https://www.coveredbridges.com/covered-bridges

A side view of the_Bridgeton Bridge.

Craig Rowen


https://www.coveredbridges.com/covered-bridges/bridgeton-covered-bridge-8
https://www.coveredbridges.com/covered-bridges/bridgeton-covered-bridge-8
https://www.nps.gov/indu/index.htm
https://www.nps.gov/indu/index.htm
https://www.indianadunes.com/explore-the-dunes/indiana-dunes-state-park/
https://www.indianadunes.com/explore-the-dunes/indiana-dunes-state-park/
https://www.indianadunes.com/explore-the-dunes/indiana-dunes-state-park/
https://www.indianadunes.com/explore-the-dunes/indiana-dunes-state-park/
https://www.coveredbridges.com/
https://www.coveredbridges.com/
https://www.coveredbridges.com
https://www.coveredbridges.com
https://www.coveredbridges.com/covered-bridge-festival
https://www.coveredbridges.com/covered-bridge-festival
https://www.coveredbridges.com/covered-bridge-festival
https://www.coveredbridges.com/covered-bridge-festival
https://www.coveredbridges.com/covered-bridge-festival
https://www.coveredbridges.com/covered-bridge-festival
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Craig Rowen

The Nevins Bridge built in 1920.


https://www.coveredbridges.com/covered-bridges/nevins-covered-bridge-14
https://www.coveredbridges.com/covered-bridges/nevins-covered-bridge-14
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Craig Rowen
The underside of the Nevins Bridge.


https://www.coveredbridges.com/covered-bridges/nevins-covered-bridge-14
https://www.coveredbridges.com/covered-bridges/nevins-covered-bridge-14
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Craig Rowen

The Neet Bridge built in 1904


https://www.coveredbridges.com/covered-bridges/neet-covered-bridge-10
https://www.coveredbridges.com/covered-bridges/neet-covered-bridge-10
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Craig Rowen
The McAllister Bridge built in 1914.


https://www.coveredbridges.com/covered-bridges/mcallister-covered-bridge-11
https://www.coveredbridges.com/covered-bridges/mcallister-covered-bridge-11
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Craig Rowen

The Crooks Bridge Built 1856.


https://www.coveredbridges.com/covered-bridges/crooks-covered-bridge-12
https://www.coveredbridges.com/covered-bridges/crooks-covered-bridge-12
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Craig Rowen

The Bridgeton Country Store Established 1865.
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Craig Rowen

The 1878 House in Bridgeton.



https://www.bridgeton1878house.com/Home.html
https://www.bridgeton1878house.com/Home.html
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In the Gulf States Camera Club Council’'s September Competition, Alan Daniel received First
Honorable mention for his nature image “Snake Snack”. Congratulations!

Snake Snack, Alan Daniel


https://www.gulfstatesccc.org/
https://www.gulfstatesccc.org/
https://www.gulfstatesccc.org/september-2022
https://www.gulfstatesccc.org/september-2022

Issue #10: October 2022 Page 49

State Fair of Texas: Sept 30 - Oct 23, 2022

State Fair Photography Winners:

On August 24, the State Fair of Texas released the list of 2022 Creative Arts Award winners.

There were several club members honored in the Photography category:

Happy -Go-Lucky: 3rd Place, (Child, School Age Category), Kay Hale


http://creative.bigtex.com/results/
http://creative.bigtex.com/results/
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Dynamic Dallas: Honorable Mention, (Architectural Features/Buildings Category), Kay Hale
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Alpine Art Gallery: Honorable Mention, (City Scenes Category), Kay Hale
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LILY: Honorable Mention, (Floral Category), Mary Binford
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HERON: Honorable Mention, (Birds Category), Mary Binford
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Mary Binford

BLUEBONNET: Honorable Mention, (Bluebonnet Category), Mary Binford
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PHOTOGRAPHIC SOCIETY
OF AMERICA

https://psa-photo.org/

The Photographic Society of America
(PSA), founded in 1934, is a world-wide
organization providing abundant
resources for photographers, from the
novice to the professional. PSA offers
on-line learning, webinars, study
groups, competitions, mentors and
consultants. Membership is in over 80
countries, 5,000 members, 460 Camera
Clubs and 12 Chapters across the
United States.



https://psa-photo.org
https://psa-photo.org
https://www.heardnaturephotographers.com/members-choice-1
https://www.heardnaturephotographers.com/members-choice-1
https://www.heardnaturephotographers.com/meetings
https://www.heardnaturephotographers.com/meetings
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If you are a new member, or are renewing a long standing
membership, you may want to visit our “About” Page. The Club is
an auxiliary group hosted by the Heard Natural Science Museum
in McKinney, TX. Here you will read the history of the club and
see a map of the in-person (when available) meeting location on
the Heard Natural Science Museum grounds.

The club was established in 1981 and has served the nature
photography enthusiast ever since. We are an affiliate of the

Photographic Society of America and focus our attention on
nature photography.

We have a distinguished list of Honorary Life Members and all
Past Presidents are listed.

The Bylaws and Policies are also available.

Although meetings cannot be in person at this time, the Heard

Natural Science Museum and Wildlife Sanctuary is currently open

and we encourage you to grab your camera and take a winter
walk! Visit their EACEBOOK page for updated activities.

Membership to the Heard is available at different price levels, as

well as activities for all ages.

CLUB WEBSITE

SOCIAL MEDIA LINKS


https://www.heardnaturephotographers.com/about-the-club
https://www.heardnaturephotographers.com/about-the-club
https://psa-photo.org
https://psa-photo.org
https://www.heardnaturephotographers.com/honorary-life-members
https://www.heardnaturephotographers.com/honorary-life-members
https://www.heardnaturephotographers.com/club-presidents
https://www.heardnaturephotographers.com/club-presidents
https://www.heardnaturephotographers.com/bylaws-policies
https://www.heardnaturephotographers.com/bylaws-policies
https://www.heardmuseum.org/directions
https://www.heardmuseum.org/directions
https://www.facebook.com/ConnectwithNature
https://www.facebook.com/ConnectwithNature
https://www.heardmuseum.org/membership
https://www.heardmuseum.org/membership
https://www.heardnaturephotographers.com
https://www.heardnaturephotographers.com
https://www.heardnaturephotographers.com/april-meeting
https://www.heardnaturephotographers.com/april-meeting
https://www.heardnaturephotographers.com/mike-mezeul-video
https://www.heardnaturephotographers.com/mike-mezeul-video
https://www.heardnaturephotographers.com/cedars-on-the-brazos-2019
https://www.heardnaturephotographers.com/cedars-on-the-brazos-2019
https://www.heardnaturephotographers.com/newsletter-archive
https://www.heardnaturephotographers.com/newsletter-archive
https://www.facebook.com/groups/HeardNP
https://www.facebook.com/groups/HeardNP
https://www.instagram.com/explore/tags/heardnaturephotographers/
https://www.instagram.com/explore/tags/heardnaturephotographers/
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Contest VWebsite

Thank You!! Thank you for being a supportive member of the
Heard Nature Photographers Club. We really appreciate having
you as a part of our growing family. Our association is better
because of you.

Membership in the club is only $10 this year. Use the link on this
page to renew your membership.

Remember that, as a member, you can participate in some
awesome field trips when the club once again meets in person.
Our meeting speakers provide incredible insight into photography

and our host, the Heard Natural Science Museum, is an incredible
facility.

Currently, members are able to take advantage of excellent
speakers via ZOOM meetings and the club often meets in
conjunction with area photography clubs while meetings are
canceled.

If you are a first time member, you may want to read about the

club. The Heard Nature Photographers Club is an auxiliary group
of the Heard Natural Science Museum, McKmney, Texas. Click

he w

Membership is $10. per year for 2022 and reverts to $20. per
year for 2023. You will be able to pay by credit card.

Dues can be paid via PayPal directly to
membership@heardnaturephotographers.com

Other options are to send a check made payable to:
Heard Nature Photographers to:

Treasurer, Brian Clark

Heard Nature Photographers

441 Cherry Spring Drive

McKinney, TX 75072



https://www.heardnaturephotographers.com/membership
https://www.heardnaturephotographers.com/membership
https://www.heardmuseum.org/
https://www.heardmuseum.org/
https://www.heardnaturephotographers.com/
https://www.heardnaturephotographers.com/
https://www.heardmuseum.org/
https://www.heardmuseum.org/
https://www.heardnaturephotographers.com/bylaws-policies
https://www.heardnaturephotographers.com/bylaws-policies
https://www.heardnaturephotographers.com/bylaws-policies
https://www.heardnaturephotographers.com/bylaws-policies
https://www.heardnaturephotographers.com/membership
https://www.heardnaturephotographers.com/membership
mailto:membership@heardnaturephotographers.com
mailto:membership@heardnaturephotographers.com
https://dewittcshutterbugs.com/annual-photo-contest/
https://dewittcshutterbugs.com/annual-photo-contest/
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GREETING CARD DESIGNER

ROB HULL

It’s getting to be that time of year when you want to share your artistry with friends and family. I’'m talking
about creating your own greeting cards, it’s a powerful and unique way to share your work.

Once you understand the process, greeting cards can be designed and printed quickly. But be forewarned, you
need to do a little homework first. Also, remember that we are talking about using your own inkjet printer, not
sending them out to a lab.

First I’ll share with you the steps necessary to create a card from scratch in Photoshop. And then, I'll share with
you some actions that automate the process.

Before you get started
Before you march headlong into Photoshop you need to understand a few key limitations for laying out
greeting cards.

Greeting cards are usually printed on special paper stock. Like standard photo papers, you can purchase
greeting card stock in glossy or matte finishes or even elegant artistic papers. These papers, however, are
scored to accommodate the fold and are cut in unusual dimensions that will result in standard folded
dimensions. For example, if you wanted a 5” x 7” greeting card, the pre-scored stock will be 10” x 7”.

This brings us to our most important limitation. Because greeting card stock is usually cut to non-standard
dimensions, there are few printers that have the capability to print borderless images using these papers.
You'll find that even with a printer that is advertised to print borderless, the feature is limited to specific
standard sizes such as 8” x 10”7, 5” x 7” and 4” x 6”. Because of this you need to allow for a non-printable
margin on all sides of the card.
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The size of this margin depends upon the minimum margin for your specific printer model. To find this look in
the printer reference manual for the section that describes the Printable Area. The sample above is for an
Epson photo printer and you’ll see the minimum margin is 3mm or 0.12”. We'll use this for our sample card.

Lay Out Your Card

Now that you have all the printer specifications and know the size of the greeting card you want, it’s time to
open an image and create a card. In our sample card, we are going to create a 5” x 7” card and prepare it for a
printer that has a minimum margin of 0.12”. The card stock is 10” x 7”.

Open the image that you want to use for the card. It’s a good idea to do a File > Save As... to save the greeting
card using a different file name.

Select the crop tool and crop your image using the following tool options;

e Width: 6.76 inches
e Height: 4.76 inches
e Resolution: 300 ppi (or whatever you use for your printer)

Now we’ll add the unprintable margin by using the Image > Canvas Size... dialog; enter the following options;

Width: 7 inches
Height: 5 inches
Keep the Anchor in the center
Canvas extension color: White
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Now that the front of the card looks good, it’s time to add the portion that will become the back of the
card. Once again, we use the Image > Canvas Size... dialog box but this time we change the anchor point.
Where you move the Anchor point depends upon whether you are creating a portrait style or landscape
style card. In the Landscape Style sample above we move the Anchor point to the bottom. This will create
a fold above the image. (For a Portrait Style card, the Anchor point would be moved to the right.) In the
dialog box use the following options:

e Width: 7 inches

e Height: 10 inches

e Anchor: Move it to the bottom center

e Canvas extension color: White

Once complete, you're ready to print your card. You’ll need to follow your printer’s directions to know how to
load your card stock to ensure that your image is printed on the proper side of the paper. When you are done,
you will have a beautiful greeting card ready for mailing.

Greeting Card Stock

If you're looking for card stock on which to print your images, click on over to the Red River Paper website.
They have a tremendous assortment of greeting card stock, from Glossy and Luster cards to 100% cotton fine
art papers. My personal favorite is their 60lb. Polar Matte and I've basically standardized on the 9" x 6.25"
size. I've printed our family Christmas Card on this stock for over 10 years.

Help Laying Out Cards

If you want a little help laying out cards - and you know how to run actions in Photoshop - you should look at
my Greeting Card Designer actions. It's a set of actions that run on Photoshop and lay out the card for you.
You can find them at www.PlayWithYourPixels.com.



http://www.PlayWithYourPixels.com
http://www.PlayWithYourPixels.com
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card samples





https://www.greatphotography.com/rob-hull
https://www.greatphotography.com/rob-hull

Craig Rowen



